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A

Legal notice



Copyright and trademark information relating to this product release.

Copyright © 2000–2017 SDL Group.

SDL Group means SDL PLC. and its subsidiaries and affiliates. All intellectual property rights contained

herein are the sole and exclusive rights of SDL Group. All references to SDL or SDL Group shall mean SDL

PLC. and its subsidiaries and affiliates details of which can be obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including those in

copyright in the content of this website and documentation are owned by or controlled for these

purposes by SDL Group. Except as otherwise expressly permitted hereunder or in accordance with

copyright legislation, the content of this site, and/or the documentation may not be copied, reproduced,

republished, downloaded, posted, broadcast or transmitted in any way without the express written

permission of SDL.

Trados GroupShare is a registered trademark of SDL Group. All other trademarks are the property of

their respective owners. The names of other companies and products mentioned herein may be the

trademarks of their respective owners. Unless stated to the contrary, no association with any other

company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can be found by

clicking the following link: Acknowledgments on page 0 .

Although SDL Group takes all reasonable measures to provide accurate and comprehensive information

about the product, this information is provided as-is and all warranties, conditions or other terms

concerning the documentation whether express or implied by statute, common law or otherwise

(including those relating to satisfactory quality and fitness for purposes) are excluded to the extent

permitted by law.

To the maximum extent permitted by law, SDL Group shall not be liable in contract, tort (including

negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or damage of any

kind or arising out of, or in connection with, the use or performance of the Software Documentation

even if such losses and/or damages were foreseen, foreseeable or known, for: (a) loss of, damage to or

corruption of data, (b) economic loss, (c) loss of actual or anticipated profits, (d) loss of business revenue,

(e) loss of anticipated savings, (f ) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any

indirect, special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." Licensor makes no warranties, express, implied, statutory or

otherwise with respect to the Third Party Software, and expressly disclaims all implied warranties of

non-infringement, merchantability and fitness for a particular purpose. In no event will Licensor be

liable for any damages, including loss of data, lost profits, cost of cover or other special, incidental,

consequential, direct, actual, general or indirect damages arising from the use of the Third Party

Software or accompanyingmaterials, however caused andon any theory of liability.This limitation

will apply even if Licensor has been advised of the possibility of such damage. The parties

acknowledge that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other InternetWeb site references, is subject

to changewithout notice.Without limiting the rights under copyright, no part of this may be reproduced,

stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic,

mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written

permission of SDL Group.
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1

Welcome to SDLTrados

GroupShare Cloud



We have compiled some best practices on how to make optimal use of your SDL Trados GroupShare

Cloud space. This quick start guide is meant for users new to SDL Trados GroupShare Cloud.

The training guide will walk you through the following five topics:

1. Log in

2. Dashboard

3. Organizations, Users and Roles

4. Server-based translation memories (TMs)

5. Server-based termbases (TBs)

6. Server based projects

Additional resources for SDL Trados GroupShare support are available to you:

• The SDL Knowledge Base is available for your use at all times. Visit gateway.sdl.com .

• The SDL Trados GroupShare online help is available on the docs.sdl.com website.

SDL Trados GroupShare Cloud includes a complementary Support contract or PSMA , which you can use

for assistance, guidance or support related to any SDL Trados GroupShare Cloud issues. However, if

you need support for SDL Trados Studio, you need to purchase a separate SDL Trados Studio PSMA, if

your SDL Trados Studio license is not already covered by PSMA.

You can log a support ticket via your SDL Customer Account which can be accessed at www.sdl.com .

1 Welcome to SDLTrados GroupShare Cloud
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2

Log in



Once you have received your credentials, you can log in via SDL Trados GroupShare Cloud or via SDL

Trados Studio.

Logging in to SDLTrados GroupShare Cloud

Visit SDL Trados GroupShare Cloud to manage and set up your space.

Procedure

1. Navigate to SDL Trados GroupShare Cloud. The SDL Trados GroupShare Cloud login dialog is

displayed.

2. Select SDL Authentication, type your login details and click Login. Your user name is your email

address. You will be logged in to SDL Trados GroupShare Cloud.

Change your password from SDLTrados

GroupShare Cloud

Once you have logged in, the first thing we recommend is that you change your password.

Procedure

1. In the right-hand side corner of SDL Trados GroupShare Cloud, click .

2. SelectManage Account.

3. On the [user.name] page, under Contact information, place the cursor in the Password field and

type the new process.

4. Repeat the new password in the Confirm Password field. At this stage, you can change yourDisplay

Name, and update your Email, Phone, and Description.

Tip: Note that the Email specified here will be used by SDL Trados GroupShare Cloud to send

notifications relating to project assignments.

5. Click Finish. From now on, you will use the new password to login to SDL Trados GroupShare Cloud.

2 Log in
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Connecting to SDLTrados GroupShare

Cloud from SDLTrados Studio

After SDL Trados Studio is installed, you can access SDL Trados GroupShare Cloud from within SDL

Trados Studio.

Procedure

1. Log in to SDL Trados Studio.

2. Go to File > Setup.

3. Click Servers and click Add.

4. In the Add SDL Server dialog, enter the server address and your SDL Trados GroupShare Cloud

credentials.

5. ClickOK. You are now connected to the SDL Trados GroupShare Cloud server.

2Log in
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Change your password from SDLTrados

Studio

Once you have logged in to SDL Trados GroupShare Cloud from SDL Trados Studio, you can change your

password, if you hadn't already done so.

Procedure

1. In SDL Trados Studio, go to File > Setup.

2. Click Servers and then click Change Password.

3. Change your password and confirm it.

2 Log in

6 SDLTrados GroupShare QuickStart Guide



3

Dashboard



You can view a comprehensive status report of all the translation projects that are in progress in the SDL

Trados GroupShare Cloud Dashboard.

The Dashboard is the first view displayed when you visit SDL Trados GroupShare Cloud.

The Dashboard contains widgets that inform you:

• What projects are due soon

• What tasks are assigned to the currently logged user

• Which of the requested download tasks are complete

• Howmany projects were created per month

• Howmany words were translated per month

• Howmany language pairs were used percentage-wise

• Howmany words were translated per organization.

Note: The actual display of the SDL Trados GroupShare Cloud Dashboard may vary depending on the

users' access rights and their associated privileges.

3 Dashboard
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4

Organizations, Users and Roles



SDL Trados GroupShare Cloud helps you collaborate with your fellow translators and reviewers by

enabling a shared space for projects and their resources.

Before you start creating Users it is important to understand how SDL Trados GroupShare Cloud works.

Therefore, wewill briefly explain twomain concepts of SDLTrados GroupShare Cloud:Organizations and

Roles.

Organizations and Sub-Organizations

An SDL Trados GroupShare CloudOrganization can be compared to a folder inWindows Explorer.

When you create users, you assign them to anOrganization in order for them to consult and use the

resources of that Organization: the project data, the translation memories (TMs) and the termbases

(TBs).

Organizational structure

You start with only oneOrganization on the server, but you can create your own organizational

structure. To do so, log in to SDL Trados GroupShare Cloud (using your login credentials) and select the

Users view. As soon as you add an Organization (for example, an organization called "EN-FR Translators"),

you can decide to create more Organizations on the same level (by using your Root Organization as

your starting point), or you can decide to create a more nested structure with Sub-Organizations (by

creating a new 'Sub-Org' called "EN-FR External Translators", for instance). Please see the following sample

structure for reference:

The Organization tree is a predefined way of organizing your projects for regulated control and easy

access.

Limited access to resources via Sub-organizations

To provide users with limited access to anOrganization resource, you can configure a Sub-

Organization. Sub-Organizations can be created based on several factors, such as: client, translation

type or even geographical location. This way, you can ensure that users will only see the names of the

customers they work for (as well as the TMs and Projects relevant to them).

4 Organizations, Users and Roles
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Dynamic Resource Handling

SDL Trados GroupShare Cloud introduces Dynamic Resource Handling, which is an alternative way of

regulating control and setup. How is this useful for you?

SDL Trados GroupShare Cloud enables you to add users to neutral Organizations, for example an

Organization named, External Collaborators. Users who are members of neutral Organizations will not

see or access any SDL Trados GroupShare Cloud hosted data such as: projects, TMs or TBs. Only when

users are assigned to a project is access automatically granted to them, based on the requirements for

that specific project and the associated privileges granted during user creation. Access will only be

granted until users complete their task. Once completed, access is automatically revoked with no further

intervention from the Project Manager.

Add Organizations

Every SDL Trados GroupShare Cloud instance sets a unique Root Organization by default. You can add

as many Organizations to the Root Organization. Then, you can continue adding as many Sub-

Organizations to these Organizations.

Procedure

1. Go to the Users view.

2. Select the Root Organization or the Sub-Organization under which you want to create nested

Organizations.

3. Click + Organization.

4. In the Add Organization dialog:

a. Type a name for your Organization.

b. Optionally, enter a description.

5. Click Finish.

4Organizations, Users and Roles
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Users

As soon as you have completed the organizational structure, you can add users to SDLTrados GroupShare

Cloud as per your subscription. Users refer to the translators, reviewers and collaborators who work on

your translations. User creation is confined by the default roles and permissions available in SDL Trados

GroupShare Cloud. No customization is available.

For each user you will have to indicate whether this user should get access to:

• All of your Organizations, in which case you can simply select the Root Organization and the correct

role for that user

• Some of your Organizations, in which case you select the relevant Organizations and the relevant

roles

It is possible to grant users access to different individual Organizations or to assign a different role for

each Organization if required.

Note:When creating new users, you must use their email address as username.

Roles

An SDL Trados GroupShare Cloud role is a collection of permissions, which is assigned to users. The list

of available roles is fixed and it cannot be customized.

As Administrator, you give roles to users, so they can use SDL Trados GroupShare Cloud to carry out job

functions in SDL Trados GroupShare Cloud, SDL Trados Studio and SDL MultiTerm.

The SDL Trados GroupShare Cloud list of roles cannot be changed, as opposed to the regular SDL Trados

GroupShare list of roles where new roles can be added.

SDLTrados GroupShare Cloud roles

There are six roles available in SDL Trados GroupShare Cloud:

• Administrator

• Project Manager

• Translator

• External Translator

• Reviewer

• External Reviewer

The table from the SDL Trados GroupShare Online Help > Standard roles and permissions shows the

permissions assigned to each of these users. You will notice that Translators have the same permissions

as Reviewers. Similarly, External Translators have the same permissions as External Reviewers. The main

differences between Internal Translators/Reviewers and External Translators/Reviewers are that:

• External users cannot see the names of other users working on a project

4 Organizations, Users and Roles
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• External users can only see the project files that have been assigned to them (typically by an

Administrator or Project Manager)

Translators and Reviewers (whether external or internal) cannot create server-based TMs or perform TM

maintenance (exports/imports/batch edits and deletes), whereas Project Managers can. Project Man-

agers also have all the permissions related to project management (assigning users to files, adding files,

checking out any project files, etc.). Administrators can do everything, including the creation of users

and organizations.

SDLMultiTerm roles

SDL MultiTerm is a termbase module which can be integrated with SDL Trados GroupShare Cloud via a

separate installation from you SDL Customer Account. Term-related privileges are initially managed

through the role granted to users.

Add users and assign user roles

Users are defined by the roles they have within Organizations. To give your users permissions and access

to your projects and resources, you must assign them roles. Roles are helpful because they are like

labels users carry with them. Therefore, it is easy to group, filter or quickly retrieve all your types of users.

Procedure

1. Go to the Users view and select the Users tab.

2. Select the Organization to which you want to add the new user.

3. In the upper right-hand corner of the page, click New User.

4. In the Create Userwizard, fill in the account details.

4Organizations, Users and Roles
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Note: Remember that the User Typemust be SDL, and that the Usernamemust be the user's

email address.

5. Click Next and, in the Roleswizard section, choose which roles you want the new user to have

within the Organization.

6. Click Finish to create the new user and assign the selected roles.

Note: Only the System Administrator and members of the Administrator role can create, edit or

delete users. Roles assigned within an organization propagate to its Sub-Organizations.

4 Organizations, Users and Roles
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5

Server-basedTMs



Server-based translation memories (TMs) are shared repositories of previously translated text, used and

updated by concurrent users. This means that when translating you have access to the latest changes

while maintaining consistency across your entire translation work.

Server-based TMs are placed into Organizations. All the users in that Organization will have access to

the TMs in the Organization and to the TMs linked to the Organization. Moreover, Dynamic Resource

Handling ensures secure, fast and reliable access to resources and seamless collaboration inside the

Organization.

The current section covers the creation of TMs both from SDL Trados GroupShare and from SDL Trados

Studio.

Configure server-basedTMs in SDLTrados

GroupShare Cloud

Server-based TMs are managed through SDL Trados GroupShare Cloud, but stored in a space called

container, which is associated with your Organizations.

Step 1: Add containers

Upon SDL Trados GroupShare Cloud installation, a default container is set. Depending on your needs

and the complexity of your Organization, you can add asmany containers as you need. One container can

support several TMs.

Procedure

1. Go to the System Configuration view.

2. Click the Containers tab, and then click New Container.

3. In the Create Container dialog:

a. Choose a location for your container within the Organization.

5 Server-basedTMs

16 SDLTrados GroupShare QuickStart Guide



b. Choose a database server.

c. Enter a container name and a database name.

Tip: Containers enable the efficiency of the TM backup process. Backup is TM-specific and it is

performed within the TM-associated container.

d. Optionally, provide a description for your container.

4. Click Finish.

Step 2: Create server-basedTMs

Create server-based TMs to store and share your translations in an online environment.

Procedure

1. Go to the Resources view.

2. In the Translation Memories tab, click NewTranslation Memory.

3. On the General Settings page:

a. Type the TM details.

b. Choose a location for your TM.

4. Select Next.

5. On the Language Pairs page, select the source and target languages for your language pairs.

5Server-basedTMs
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6. Select Next.

7. Optionally, on the Fields page, do any of the following:

• Select a field template. The field columns are automatically updated with the template content.

• Configure the field columns.

• Leave the field columns blank.

8. Select Next.

9. Optionally, on the Language Resources page, select a language resource template or configure

each language resource.

• If you select a field template, the field columns are automatically updated with the template

content

• If you select , edit the fields and click Finish.

10. Select Next.

11. On the Advanced Settings page, review the default checkboxes, and select or clear, if necessary.

5 Server-basedTMs
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12. Click Finish.

Tip: If you have *.tmx files, you can import them directly into SDL Trados GroupShare Cloud. A

report is available to confirm if the import is successfully completed.

Migrate file-basedTMs from SDLTrados

Studio

If you have one or more file-based TMs in SDL Trados Studio, you can easily migrate them to a server-

based format. This helps you reuse your existing content in a shared format.

Step 1: Establish your connection to SDLTrados

GroupShare Cloud

To migrate your legacy file-based TMs to a server-based format, you first need to ensure SDL Trados

GroupShare Cloud is connected to SDL Trados Studio. For more information, refer to the "Logging in to

SDL Trados GroupShare from SDL Trados Studio" section of the current quick start guide.

Step 2: Upgrade your file-basedTMs to SDLTrados

GroupShare Cloud

The TM upgrade process supports any of the following formats: *.tmx (SDL Translation Memory
Exchange Documents), *.tmw (SDL Trados Studio 2007 File-based Translation Memories), *.mdb (SDLX
2007 File-based Translation Memories), *.txt (SDL Workbench or WinAlign Export) and *.sdltm (SDL
Trados Studio 2011 File-based Translation Memories which you want to merge into a new TM). Once
the TM upgrade process is complete, your TM is upgraded to the *.sdltm format. Creating server-based
TMs and importing file-based data can also take place directly from within the Translation Memories

view of SDL Trados Studio, but this process requires several manual tasks. As a result, SDL recommends

that you take advantage of the automated process detailed below.

5Server-basedTMs
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Procedure

1. On theWelcome view, on the Home tab, in the Translation Memory group, click Upgrade

TranslationMemories.

2. On the Input Translation Memories page, click:

• Add File-based TMs from Folder, to add several file-based TMs grouped under a file, to the

conversion process.

• Add File-basedTMs, to add one or more file-based TMs individually, to the conversion process.

3. Click Next.

4. On theOutput Translation Memories page, decide whether you want to create a TM for each

input TM or for each language pair by choosing one of the options: Create output translation

memory for each input translationmemory, Create output translationmemory for each

language pair and Custom.

5. Click Next.

6. On theOutput Translation Memories Settings page, in the Location tab, select Server-based

translationmemory and:

5 Server-basedTMs
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a. Choose a server from the Server: list.

b. Browse for a location for your server-based TM. You basically have to choose under which

organization you want to place your server-based TM.

c. Browse for a container for your TM.

Tip: If you have more than one TM listed, repeat step 7 for each TM.

7. Click Finish.

Link resources across Organizations

When one of your Project Managers creates a server-based TM, this TM is always stored in a container on

your server. Your custom containers, servers and TMs are stored in your Root Organization. However, if

you created users who do not have access to the Root Organization, they will be restricted from:

consulting the list of available servers and containers, adding server and containers, and creating TMs.

What can you do to give these users access to your resources? You can simply link servers, containers and

TMs to the Organization where users have access to.

About this task

TM links allow users from other Organizations to access your TM. It will often be the case that TMs need

to be shared among several Organizations. Imagine, for example, a scenario in which you have a TM

related to the domain IT, which you use for different customers. It would be troublesome if you had to

copy that TM into each Organization you created for those individual customers. In this case, you can

simply link the TM that you stored in one Organization, to another one - like creating a shortcut in

Windows Explorer. By doing this, you make sure that users will be able to access the TM, whether they

aremembers of one Organization or the other. Resource linking is only required if you are not fully relying

on Dynamic Resource Handling.

Procedure

1. In SDL Trados GroupShare Cloud, go to the Users view and select the Contents tab.

2. Select the organization where the resource (container + TM; TB) is located.

3. Select the resource you want to link.

Note: Containers include TMs, therefore when you link a container, you must link its associated TM

as well (and vice versa). TBs (termbases), on the other hand, are not container-dependent.

4. Click Link Resource.

5. In the Link Resources dialog, select the location where you want the resource to be linked. This

location is the Organization users have access to.
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6. Click Finish.

Tip: If you want to physically move the resource out of an Organization and into another one, you

can follow the procedure above, but use theMove Resource button.When you no longer want to

share a resource, click Unlink Resource.

Server-basedTMs in SDLTrados Studio

Server-based TMs can be used either as part of server-based projects, or simply as part of file-based

projects, by adding server-based TMs.
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6

Server-based termbases



Server-based termbases (TBs) are shared databases containing terms and term-related information. The

terms may be single words or short phrases, in multiple languages, representing industry-specific or

company-specific terminology. Server-based TBs can only be created by an SDL MultiTerm Administrator

from SDL MultiTerm Desktop. SDL MultiTerm Desktop is a separate application that can be downloaded

fromwithin your SDL Customer account, at http://www.sdl.com/ .

Integration with SDLMultiTerm Desktop

In addition to server-based translation memories (TMs), users can also translate with the help of

server-based termbases (TBs). For this reason, SDL Trados GroupShare Cloud integrates with SDL Multi-

Term Desktop, which supports users in their terminology work.

A termbase consists of:

• An *xml file = term-related data

• An *xtd file = termbase definition

The *xml and*xtd files can either be created from scratch or obtained from existing file-based

termbases. Therefore, please ensure you have SDL MultiTerm Desktop installed from your SDL Account.

You need to have the rights to create server-based TBs, which is currently a privilege associated to

Administrators and Project Managers.

Convert term lists to TBs

If you have terms or internal glossaries in formats such as *Excel, you can easily convert them into a

termbase by using the free Glossary Converter application.

Procedure

1. Go to http://appstore.sdl.com/ .

2. Go to the Apps for terminology section and click Glossary Converter.

3. Click Download.

4. In the Download App dialog:

a. Select a version.
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b. Select the checkbox corresponding to the Terms and Conditions section.

c. Click Continue.

5. SaveGlossaryConverter. zip.

6. OpenGlossaryConverter. zip, and then right-click setup.

7. On the Glossary Converter - Install ShieldWizard, clickNext.

8. Click Yes.

9. Click Finish.

What to do next

You can now drag and drop your file, and convert it, provided it is in a supported format.

Gathering requirements from file-basedTBs

If you already work with file-based TBs, you may want to create server-based TBs starting off from the

file-based ones. This can save you a lot of effort, as your new server-based TBs will preserve the structure

and data of your file-based ones. The first step you need to take is extract the structure (*.xdt file) and
data (*.xml file) from your file-based TBs. You will need these files during the creation process of
server-based TBs.

Procedure

1. In SDL MultiTerm Desktop, go to the Terms view.

2. On the Home tab, clickOpen Termbase.
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3. Go to the Termbase Management view, right-click Definition, and, on the context menu, click

Save. This will provide you with an *.xdt file, containing your termbase structure.

4. Click Export, then right-click Default export definition, and, on the context menu, click Process.

This will provide you with an *.xml file, containing your termbase data.

5. On the ExportWizard - Step 2 of 8 page, on the right-hand side of the Export file: box, click Save

As.
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6. Type a name for your *.xml file, and then click Save.

7. On the ExportWizard - Step 2 of 8 page, clickNext.

8. On the ExportWizard - Step 8 of 8 page, clickNext.
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9. On the ExportWizard page, click Finish.

Connect to SDLMultiTerm Administrator

SDL MultiTerm Administrator is an application which enables you to create the server-based TB and

manage the MultiTerm users who have access to SDL Trados GroupShare Cloud projects and resources.

You can access SDL MultiTerm Administrator by adding it to SDL MultiTerm Desktop 2017.

Procedure

1. Log in to SDL MultiTerm Desktop.

2. Go to File > Setup > Servers.
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3. On the Servers page, click Add.

4. On the Add SDL Server page:

a. Type the SDL Trados GroupShare Cloud server address.

b. Select The server requires a secure connection (SSL). The port changes from 80 to 443.

c. Select Use SDL authentication and provide your SDL Trados GroupShare Cloud user name

and password.

5. ClickOK.

Remember: Only the Administrator has access to SDL MultiTerm Administrator.
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Results

SDL MultiTerm Administrator is now added to SDL MultiTerm Desktop and you can start creating

server-based termbases.

Convert file-basedTBs to server-basedTBs

Up to this point, you extracted your termbase structure (*.xdt file) and your termbase data (*.xml file)

from an available file-based TB. You also connected to MultiTerm Administrator. It is now time to create

a server-based TB starting from its file-based version.

Procedure

1. Log in to SDL MultiTerm Desktop and make sure you added SDL MultiTerm Administrator.

2. On the Home tab, click Add/Create.

Tip: Alternatively, right-click Server, and, on the context menu, click Add/Create.

3. On the TermbaseWizard page, click Next.
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4. On the TermbaseWizard - Step 1 of 5 page, select Load an existing termbase definition file,

click Browse and choose the *.xdt file you extracted during the gathering prerequisites step.

Note: Alternatively, you can select the Create a new termbase from scratch option, which is

detailed further down the document.

5. On the TermbaseWizard - Step 2 of 5 page:
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a. Type a name for your termbase.

b. Optionally, provide a description.

c. Browse for the SDL Trados GroupShare CloudOrganizationwhere you want to store the

termbase.

6. On the TermbaseWizard - Step 3 of 5 page, use the Languages drop-down list to select your

languages of interest, and click Add or Remove to include them in your termbase. Click Next.

7. On the TermbaseWizard - Step 4 of 5 page, consult the fields that you can use to store your terms

against. You can add customized fields by typing them under Field label and clicking Add. For

the purpose of this exercise, we will keep the default fields which originated from your *.xdt file.
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8. On the TermbaseWizard - Step 5 of 5 page, use Add or Remove to customize the Entry structure

of the termbase (on the left) with the Available descriptive fields (on the right). For the purpose

of this exercise, we will keep the default structure.

9. On the last page of the TermbaseWizard, click Finish.

10. In the Administrator view, under Server, expand the server-based termbase of interest.

11. Expand Public Objects, click Import, right-click Default import definition, and, on the context

menu, click Process.

12. On the ImportWizard - Step 2 of 8 page, on the right-hand side of the Import file: box, click

Browse.
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13. On theOpen page, select the *.xml file containing your termbase data, and then clickOpen.

14. On the ImportWizard - Step 2 of 8 page, clickNext.

15. On the ImportWizard - Step 3 of 8 page, on the right-hand side of the Exclusion file box, click

Save As. Exclusion files (*.xcl) are created to store any invalid entries saved during the import
process.
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16. On the Save As page, type a name for your exclusion file, and then click Save.

17. On the ImportWizard - Step 3 of 8, clickNext.

18. On the ImportWizard - Step 7 of 8, clickNext.
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19. On the ImportWizard - Step 8 of 8, clickNext.

20. On theWizard Complete page, click Finish.

Create server-basedTBs from scratch

You can also create a server-based TBs from scratch, which means that you will manually define all the

details of your termbase structure.

Procedure

1. Perform steps 1 to 3 from the previous topic "Convert file-based termbases to server-based

termbases".

2. On the TermbaseWizard - Step 1 of 5 page, select Create a new termbase definition from

scratch.
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3. On the TermbaseWizard - Step 2 of 5 page:

a. Type a name for your termbase.

b. Optionally, provide a description.

c. Browse for the SDL Trados GroupShare CloudOrganizationwhere you want to store the

termbase.

4. On the TermbaseWizard - Step 3 of 5 page, use the Languages drop-down list to select your

languages of interest, and click Add or Remove to include them in your termbase. Click Next.
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Tip: Terminology can be dependent or independent on regions. Use Show sublanguages as you

see fit.

5. On the TermbaseWizard - Step 4 of 5 page, type a field label name under Field label and click

Add.

Note: For each field label or description field which you apply to your terms, you can specify the

data type.

6. On the TermbaseWizard - Step 5 of 5 page, use Add or Remove to customize the Entry structure

of the termbase (on the left) with the Available descriptive fields (on the right).
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Note: Term verification from within SDL Trados Studio is based on the fields that are placed at

term level, such as Status. Any given field can be placed in more than 1 level such as term level or

index level.

7. On the last page of the TermbaseWizard, click Finish.

SDLMultiTerm user roles

Only members of the Administrator role have access to the SDL MultiTerm Administrator component of

SDL MultiTerm Desktop. Administrators are responsible for server-based termbase administration

and MultiTerm user management.

Users get access to server-based termbases based on the roles assigned to them in SDL MultiTerm

Administrator. By large, users automatically gain read-only access rights to termbases, as part of the

privileges associated to translators or external users for example.

Administrators must consult the privileges or rights associated to user roles (Expert User and Public), and

decide where termbases are placed within SDL Trados GroupShare Organizations for restricted access.

Administrators can also customize the restrictions they may wish to impose on users.
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Server-basedTBs in SDLTrados Studio

Server-based TBs can be used either as part of server-based projects, or simply as part of file-based

projects, by adding server-based TBs.
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7

Server-based projects



Now that you have added your users and assigned them specific roles, created one or more server-based

TMs and/or TBs where access is granted either directly from within the associated Organization or via

Dynamic Resource Handling, you can create server-based projects. Server-based projects help you store

and manage the content which needs to be translated.

View server-based projects in SDLTrados

GroupShare Cloud

To check the details of a server-based project at a glance, check the Projects view and consult a project's:

name, publish date, delivery date, recipient, status, language pairs and location within SDL Trados

GroupShare Cloud.

Procedure

1. Go to the Projects view.

2. Consult all your available project in the All projects tab.

Tip: Use the side Filter bar to sort your projects by Publishing date, Delivery date, Status or

Organization.

Create server-based projects from the SDL

Trados GroupShare Cloud workflow

You can manage shared projects and file assignments directly from SDL Trados GroupShare Cloud.

Once a project is created in SDL Trados GroupShare Cloud and users are assigned work, you can:

• Search for the project in the Projects view.

• Open the project tab, and consult the project planning board and statistics.

• Move the project files on the task assignment board to mark their progress.

To manage GroupShare projects via SDL Trados GroupShare Cloud:

1. Make sure that you are a member of the Project Manager role or that you are in a role which includes

the permissions required for managing file assignments.

2. Follow the workflow steps:

7 Server-based projects

42 SDLTrados GroupShare QuickStart Guide



Step 1: Add the project template

Before you can create a project directly from within SDL Trados GroupShare Cloud, you need to have an

SDLTrados Studio project template file to start with. Use SDLTrados Studio to create a project template

(*.sdltpl) file. Project templates store settings such as: file types, TMs, TBs or other project-related data

such as enforced QA settings.

Procedure

1. Log in to SDL Trados GroupShare Cloud and go to the Resources view.

2. In the Project Templates tab, click New Project Template.

3. In the New Project Templatewindow:

a. Type a name and optionally a description for your project template.

b. Choose a location for your project template within your organization.

c. Browse for your template file.

4. Click Create.

Step 2: Create projects fromwithin SDLTrados

GroupShare Cloud

After you added the project template to SDL Trados GroupShare Cloud, you can create the actual shared

project. A shared project is a storage for all the files that need to be translated. At this stage, you also

decide which Organization is in charge of your project.
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Procedure

1. Create a *zip archive of the files you want to translate.

2. In SDL Trados GroupShare Cloud, go to the Projects view.

3. ClickNew Project.

4. In the New Projectwindow:

a. Type a name, and optionally a description for your project.

b. Choose a location for your project in your organization.

c. Choose a project template from the list.

d. Browse for the *zip archive containing your project files.

e. Optionally, set a due date for your project.

5. Click Create.

Step 3: Plan work on assignments

Once you have created the project, you can assign users to each of the supported phases, for each

project file. Each of the users you assign at this stage will be notified by email when the file reaches the

phase users are assigned to. As Project Manager (or as a user with relevant permissions) you can change

the assignments in SDL Trados GroupShare Cloud any time during the project lifecycle. When you

assign users to project phases, they are granted access to the project and its resources automatically, if

role assignment and resource allocation were performed correctly in SDL Trados GroupShare Cloud.
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Procedure

1. In SDL Trados GroupShare, go to the Projects view.

2. Click a project to open it.

3. On the project planning board, set to the task assignment layout, select one or more files.

4. Click Planning for <n> files.

5. For each phase, in the Planning for <file> window:

a. Assign the users that work on the files from the Assigned users list.

b. Specify a due date in the Delivery at field.

c. Activate phase based on the next logical task to be completed.

6. Click Save.

The assigned user receives a notification email regarding the task assigned to them and the due

date for it.

Step 4: Complete task assignments in SDLTrados

Studio

All users need to work within SDL Trados Studio if they want to collaborate through a supported SDL

Trados GroupShare Cloud workflow, using any licensing type.When the Project Manager moves project

files to a phase in SDL Trados GroupShare Cloud, the users who are assigned to that phase receive

automatic notification emails. The notification emails inform users of the tasks they must work on and of

the due date. The assigned users can start working on their translation or review tasks in SDL Trados

Studio. For more information, consult "Step 4Working on task assignments" of the "Create server-based

projects using the SDL Trados Studio workflow" section. Files can be opened for translation, for review

or for sign-off. Each mode by which you open the files gives you a customized view listing the relevant

features you need to complete the task. Note that it is possible to use file-based projects while relying on

SDL Trados GroupShare Cloud for centralizing your server-based TMs and TBs for licensing.
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Step 5: Change project status to Complete

When users finish working on all assignments, you can change the project status from In progress to

Complete. At this stage, all the project files are usually in the Finalisation phase. The status change takes

place from within SDL Trados GroupShare Cloud.

Procedure

1. In SDL Trados GroupShare Cloud, go to the Projects view.

2. Select the checkbox(es) corresponding to the project(s) you want to complete.

3. ClickMark as Completed.

The project status changes to Completed.

Viewing server-based projects in SDLTrados

Studio

To check the details of a server-based project in SDL Trados Studio at a glance, go to the Projects view

and consult a project's: name, status, delivery date, creation date, location, server and Organization.

Procedure

1. Log in to SDL Trados Studio.

2. Go to the Projects view.

3. Consult the details of all available SDL Trados GroupShare Cloud projects. The following icons signal

an SDL Trados GroupShare Cloud project in various stages of development:

• - the project is publishing

• - the project is published

• - the project publish failed

Create server-based projects using the SDL

Trados Studio workflow

SDL Trados Studio and SDL Trados GroupShare Cloud synchronize continuously to support your projects

and file assignments.

Once a project is created in SDL Trados Studio, you can publish it on SDL Trados GroupShare Cloud in

order to assign the project work to one or more translators and reviewers. Translations projects can be

managed in both SDL Trados Studio and SDL Trados GroupShare Cloud.

To complete a shared SDL Trados GroupShare Cloud project started in SDL Trados Studio:
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1. Make sure that you are a member of the Project Manager role or that you are in a role which includes

permissions required for publishing projects and managing file assignments.

2. Go through the workflow steps:

Step 1: Publish projects to SDLTrados GroupShare

When you publish an SDL Trados Studio project to SDL Trados GroupShare Cloud, you allowmultiple

users to work together to complete translation tasks. Two slightly different procedures are detailed at this

stage: one referring to the projects that you are currently creating and another referring to the projects

which are already created.

Publish new projects to SDLTrados GroupShare Cloud

Procedure

1. Log in to SDL Trados Studio and go to the Projects view.

2. On the Home tab, select New Project and go through the pages of the project creation wizard.

3. On the Project Type page, choose whether you want to create the project starting from a template

or from a previous project.

4. On the Project Details page, provide the relevant project information and select the Publish

project on GroupShare checkbox:
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a. Choose a server.

b. Browse a project location on the SDL Trados GroupShare Cloud server and clickOK.

5. Click Next.

6. On the Project Languages page, select the source and target languages for your project.
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7. On the Planning and Assignments page, select the Preparation tab and then:

a. Under Due date, choose an end date and time for the assignments in this stage.

b. Optionally, under Available Assignees, type a user name, especially if you have a large user

list and you want to retrieve them fast.

c. Under All Users, select the user you want to add to the project phase, and click Add. Repeat

this for as many users as you need for the project phase.

Tip: SDL recommends that you assign users to phases at this point. If, however, you decide to skip

this step or, if changes occur after you publish the project to SDL Trados GroupShare Cloud, you can

assign or unassign users from phases at a later date via the Files view from within SDL Trados

Studio.

8. Repeat step 7 for the rest of the phases: Translation, Review and Finalisation.
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9. Click Next.

10. On the Project Files page, add files or folders to your project.

11. Click Next.

12. On the TranslationMemory andAutomatedTranslation page, configure any translation resources

you want to include in your project. Use the Create or Use drop-down lists to either create a new

translation resource (TM) or to add an existing translation resource (TM).

Remember: If you want your SDL Trados GroupShare Cloud users to access the same translation

memory resources, you must create or use server-based translation memories.

13. Click Next.

14. On the Termbases page, configure any termbases you want to include in your project.
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Note: For term consistency, you need to refer to your server-based TBs, not to your file-based TBs.

15. Click Next.

16. On the Preparing Project page, choose the task sequences that will prepare and/or pre-translate

your project files. If you decide to use the Prepare batch task, this sequence includes the creation of

project translation memories.

Note: Project TMs can be file-based or server-based.

17. Click Next, and then click Close.
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Remember: For routine translation jobs, it is useful to have templates to start with. At this stage,

save the template and its assigned users.

Results

When the project is published, SDL Trados GroupShare Cloud displays the new project in the Projects

view.

SDL Trados GroupShare Cloud then analyzes the permissions of the users who are members of SDL

Trados GroupShare Cloud roles on the server, and makes the project files visible to the appropriate users

in SDL Trados Studio.

Publish existing projects to SDLTrados GroupShare

Procedure

1. Log in to SDL Trados Studio and go to the Projects view.

2. Select the project you want to publish to SDL Trados GroupShare Cloud.

3. On the Home tab, in the Trados GroupShare layout (the file assignment layout), select Publish

Project.

Note: Any file-based resources (TMs or TBs) which are linked to the project due to be published to

SDL Trados GroupShare Cloud will need to be removed and replaced with their server-based

equivalent. This is done via Project Settings.

4. In the Publish Project dialog, browse a project location on the SDL Trados GroupShare server,

selectOK and, then, select Finish.
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Results

When the project is published, SDL Trados GroupShare Cloud displays the new project in the Projects

view.

SDL Trados GroupShare Cloud then analyzes the permissions of the users who are members of SDL

Trados GroupShare Cloud roles on the server, and makes the project files visible to the appropriate users

in SDL Trados Studio. You can use filters to locate the relevant project based on type.

Step 2: Assign files to users

After publishing your project to SDL Trados GroupShare Cloud, you can delegate the translation work to

specific users, so that they can start translating or reviewing the project files. When the allocated files

reach the phase where the users are assigned to work on them, SDL Trados GroupShare Cloud automati-

cally sends the assigned users a phase change notification email. This informs the users they can start

working on the files you assigned to them.

Procedure

1. In SDL Trados Studio, go to the Files view, and, on the Home tab, select the task assignment layout.

2. Expand Assign to Users in Phase and select a phase.

3. In the Assign Users to the [phase name] Phase dialog, click Add.

4. In the Select Users dialog, select Show all users from the GroupShare server, and consult the list
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of users available on the server where the project is published.

5. Select the user you want to assign work to and selectOK.

6. In the Assign Users to the [phase name] Phase dialog, selectOK.

7. Repeat steps 3 - 7 to add users to all the phases the file(s) will go through.

Note: If you add or remove assigned users during the current phase, SDL Trados GroupShare Cloud

sends an assignment change email.

Step 3: Change the active file phase

Once users have been allocated to the files, you can set the project phase according to the task which

needs to be completed.

Procedure

1. In SDL Trados Studio, go to the Files view and select one or more files.

2. On the Home tab, expand Change Phase and assign project files to one of the four available

project phases.
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Results

SDL Trados GroupShare Cloud displays the current phase of each file in the Projects view when you

open a project. This information is visible to all the users who have permission to see the project files.

Step 4:Work on task assignments

When the assigned users receive notification of a pending assignment, theymust check out the assigned

file from SDL Trados GroupShare Cloud.

Procedure

1. In SDL Trados Studio, go to the Projects view, and specify a local user path where you store your

own user-specific copy of the project.

Tip: Alternatively, click the link in the notification email to open your SDL Trados GroupShare

Cloud project to your assigned files.

2. Go to the Files view and double click the files you want to check out.

3. On the Home tab, select one of the following:Open For Translation,Open For Review,Open For

Sign-off, depending on your assigned tasks and project phases.

4. Select Check out.

Tip:When users check out their assigned files, SDL Trados GroupShare Cloud shows this informa-

tion to all users associated to this project, in the Checked out to column, in the Files view.

5. Start working on the file.
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Tip: If the Project Manager wants to roll back to a previous version of the file, they can right-click

the file and select Download Specific Version. Moreover, the Project Manager can cancel any file

that is checked out by a user for reassignment.

Step 5: Advance assignments to the next phase

Once the assigned users complete their translation or review work, they must check the files back to

SDL Trados GroupShare Cloud and advance them to the next project phase.

Procedure

1. In the Files view, select the file you want to check in.

2. On the Home tab, select Check in.

3. Expand Change Phase and select the next phase the file should go to.

Note: If there are users already assigned to work on the file in the new phase, SDL Trados Group-

Share Cloud sends these users a phase change notification email and updates the information in the

Current Phase column.

Step 6: Change project status to Complete

At the end of the project, when all translation or review work is finished, all project files are usually in

the Finalisation phase. This is an indication that users have completed all the assignments. It is best

practice to run the Finalize batch task. During this step, theTMswill be updatedwith the latest, approved

version of the translation, and the target files will be generated. Thereafter, you can mark the project as

Complete.
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Procedure

1. Log in to SDL Trados Studio.

2. Go to the Projects view and select the project you want to complete.

3. On the Home tab, clickMark as Complete or use the project menu.

Note: Users cant finalize or mark the project as Complete if there are still files checked out by

users.

Results

The project now has the Complete status. The Project Manager can retrieve the translated files from the

project folder. By default, the project path is C://Users/USERNAME/Documents/Studio 2017/

Projects. Users can also choose to no longer list the project from within SDL Trados Studio, by right-

clicking the project and selecting Remove from list.
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8

Additional details



Browser compatibility

SDL Trados GroupShare Cloud is compatible with the latest versions of Internet Explorer, Safari, Firefox,

and Chrome.

Support services

SDL Trados GroupShare Cloud support service is available via your SDL account.

Supported SDLTrados Studio versions

SDL Trados GroupShare Cloud supports the following SDL Trados Studio versions: SDL Trados Studio

2015 and SDL Trados Studio 2017.

Help resources

More advanced technical requirements/topics can be consulted in the online help .

Want to see a demo?

Just click here! https://sdl.webex.com/sdl/lsr.php?RCID=2cabb931dc2fb848668210666b3e9a40 .
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